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Module 5

UNDERSTANDING DATABASES

Key Concepts
A database is an organised collection of data. We are familiar with many examples of
databases that are not computerised. These include telephone directories, address
books and TV programme listings. All of these have well organised data referred to as
information.
A telephone directory book lists the name, surname, address and phone number of
every subscriber. This data is sorted in alphabetical order according to the surname of
the subscriber. Accordingly you can only search for a phone number provided you
know the person’s surname. However, a database program with the same information
as that found on a telephone directory enables you to search a phone number using
any piece (name, address and phone number) of information, which you know about
the person.
Storing a database on a computer:


increases the speed with which one can get information;



makes it easy to store large amounts of information can be sorted;

Typical uses of large-scale databases include airline booking systems, government
records, bank account records and hospital patient details.

Database Organization
A database file stores data in tables. A table stores and displays related data in a
spreadsheet-like format with columns (called fields) and rows (called records).
Each column in a table is called a field and represents a specific piece of data, such as
ID card, surname, firstname etc. Fields may contain text, numbers, dates etc.
Fields

Field Names

Record

IDCard

Surname

FirstName

DateOf
Birth

Average
Mark

PassFail

Phone

Fee

88286M

Abela

Maria

17/12/86

56

Y

21464646

€245

78587M

Bonnici

Caroline

03/03/87

87

Y

21464545

€245

67386M

Callus

Phyllis

04/04/86

35

N

21464343

€245

Data Value

To identify each column of data, the first row in the database table contains the field
names. Each field name is unique and represents the smallest unit of data.
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Each row in a database table is called a record and represents all of the related fields
on one line. For example, all of the information about one student, ID card, surname,
name, date of birth, average mark, pass/fail, phone and fee make up one record. The
diagram shown above displays three records.
Each item of data in a database table is referred to as a data value or data item.

Primary Key

Data type

ID Card

Surname

FirstName

Date Of
Birth

Average
Mark

Pass Fail

Phone

Fee

88286M

Abela

Maria

17/12/86

56

Y

21464646

€245

text

text

text

date/time

number

Y/N

text

currency

The data type determines the kind of data that can be stored in a table field. Data
types include text, number, date/time, yes/no, currency etc.
Referring to the above diagram, the data type for the:


‘ID Card’ field is text because the data consists of a mix of numbers and an
alphabet letter;



‘Date of Birth’ field is date/time;



‘Average Mark’ field is number;



‘Pass Fail’ field is y/n. The data values allowed in this field are ‘Y’ or ‘N’;



‘Phone’ field is text even though the data value consists of numbers. Typically
the number data type is reserved for fields containing numbers that will be
used for calculations. It is unlikely that you will perform calculations on phone
numbers;



‘Fee’ field is currency.

The field properties determine how the data in a particular field will be displayed. For
example you can determine the format of the ‘Date of Birth’ field i.e. whether you will
enter a long date, short date or medium date. You can also set the maximum number
of characters that can be entered in the ‘id card’ field by setting the field size. You can
also set a default value in a field. There are other field properties which will be
discussed later on.
A primary key is a field that uniquely identifies each record in a database table. It is a
field containing data that is different for every record in a database. Examples of
primary keys include identity card numbers, passport numbers, index numbers, and
item code numbers.
Indexes are commonly used in books to look for any particular information quickly.
Similarly, databases use indexes to speed up searches on a table using a given field.
An index speeds up searches on the indexed fields as well as sorting and grouping
operations. For example, if you search for specific students using the ‘surname’ field,
you can create an index for this field to speed up the search. By default, the primary
key field in a table is automatically indexed. However, you can set indexing on other
fields in a table.

2
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Relationships
Consider a computerised book borrowing system of a school library. If the database
contains a single table for all data, there will be duplication of data. For example,
borrowers having more than one book on loan will have their contact information
repeated for each book they borrow.
IDNo
8776M
8776M
4877M

Surname
Borg
Borg
Cilia

Name
John
John
Maria

Address1
142
142
My Nest

Address2
Main Str
Main Str
Narrow Str

Town
Qormi
Qormi
Zebbug

Postcode
QRM02
QRM02
ZBG02

CopyNo
23156
23168
23175

BookTitle
Future Cars
Solar Energy
Fashion in 1500

DateDue
14/12/04
14/12/04
14/12/04

Repeating the same information on different rows in a table is not very efficient.
Rather than having data organised in a single table, the data will be organised in
separate tables. Relationships will be defined between each table.
Consider the school library example: the data can be organised in three separate
tables:
1. a table to store data about borrowers,
2. a table to store data about books and
3. a table to store data about book loans.

There are three tables: tblBooks, tblBorrowers and tblLoans. When the library acquires
a new book, the details are entered in the tblBooks. All the members of the library
have their details entered into the tblBorrowers. When someone borrows a book, the
tblLoan is used.
The information about the book and the borrower does not have to be entered each
time a loan is made because this information is taken from the tblBook and the
tblBorrower. This is indicated by the lines that link the tables together. These links are
known as relationships.
Looking at the above diagram you will notice that tblBooks and tblLoans are related
through the CopyNo field. The tblLoans and tblBorrowers are related through the IDNo
field. A relationship is therefore built by matching a unique field in one table with a
field in another table.
Therefore a database stores data in separate tables, based on subject matter, but the
tables are brought together through relationships. The main purpose of relating tables
in a database is to minimise duplication of data.
Another benefit of setting up relationships is data integrity. Referential integrity is a
system of rules that MS Access uses to ensure that relationships between records in
related tables are valid and that you don’t accidentally delete or change related data.

3

Typically databases used in schools, companies, banks etc are designed and created
by database specialists. Office staff will enter and maintain data in databases. Office
staff also use databases to retrieve information.
The database administrator provides office staff with access to specific data on the
database. The database administrator is responsible for recovery of a database after a
crash or major errors.

4
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USING THE APPLICATION

MS Access is an example of a database management system – an application that
enables you to create and manage a database on a computer. MS Access comes in a
variety of versions. Over the years the program has been updated, making it more
powerful and easier to use. These course notes are based on MS Access 2010.

Opening & Closing MS Access
To open MS Access:
1.
2.
3.
4.

Click Start button.
Select All Programs.
Click Microsoft Office.
Click Microsoft Access 2010.

On entering MS Access you are presented with a Getting Started with Microsoft Office
Access screen. From here you can create a new database, open an existing database,
or view content from Microsoft Office Online.

5

To close MS Access:
1.
2.

Click File tab.
Click Exit.

Opening & Closing Database Files
To open a database file:
1.
2.
3.

Click File tab.
Click Open. The Open dialog box is displayed.
Select the drive and/or folder (e.g. Desktop) that contains the database to
open.

4.

Double-click the database you want to open. MS Access displays the Security
Warning.

5.

Click Enable Content button.

Note that:

6



MS Access database files end with the extension .accdb.



You can also open a recently used database file by clicking the File tab and
choosing Recent. A sub-menu showing a list of recently used documents is
displayed. Click the name of the document you want to open.



You can open a database file using the shortcut key combination: CTRL+O
keys and follow steps 4 and 5 as above.
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When you open an existing database (or create a new database), the database
window will be displayed.

Object list
within Tables

Navigation Pane with
Database Objects

An Access database contains several components known as objects:


A table stores and displays related data in a spreadsheet-like format with
columns and rows.



A query is a question you ask about your data that retrieves specific records
from one or more tables.



A form is a customised view of the data used to facilitate the entry, viewing or
editing of data in tables by displaying one record at a time.



A report is used for designing a printed copy of database information,
grouping records into several levels and performing calculations.

To close a database file:
1. Click the File tab.
2. Click Close Database.

7

Creating New Databases
To create a new database file:
1.
2.
3.
4.

Click File button.
Click New.
Click Blank database.
In the Blank database pane (right), type a name for your
database in the File Name field e.g. one.

5.

Click Browse to a location to put your database button. The File New
Database dialog box is displayed.
Browse to the drive/folder where the database file will be saved.
In the File name: field type the name of the database file e.g. test.

6.
7.

8
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Click OK button.
In the Blank Database pane, click Create button.

Note that:


Database file names can have up to 255 characters including spaces. File
names cannot include any of the following characters: forward slash (/),
backslash (\), greater than sign (>), less than sign (<), asterisk (*), period
(.), question mark (?), quotation mark ("), pipe symbol (|), colon (:), or
semicolon (;).

9

Minimising & Restoring the Ribbon
You can minimise the Ribbon i.e. the row of buttons below each tab:
1.
2.

Right-click on one of the tabs e.g. the View tab.
Click Minimise the Ribbon. This will hide the Ribbon, leaving only visible the
Ribbon's tab headers.

Note that:


Clicking on any of the tabs will now display the tab's commands, and hide the
ribbon once you have clicked on a command, or placed your mouse cursor
(pointer) back inside MS Access screen.

Using Help
1.

Click Help button. The Access Help window is displayed.

2.

Click one of the main topics e.g. Access 2010 database design basics.
This will display sub-topics. Click the sub-topic to display.
You can type a keyword or question e.g. relationships in the search field.
Click Search button. Click the topic to display.

3.

10

Click Close button to close the Access Help window.
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Opening, Saving & Closing Database Objects
As indicated earlier, the database window displays the objects: tables, queries, forms,
reports etc.
To open a table, query, form or report:
1.
2.

In the Navigation pane, click All Access Objects drop-down menu.
Click Tables, Queries, Forms or Reports.

3.

Double-click the name of the table, query, form or report to open.
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To save a table, query, form or report click the Save button in the Quick Access
toolbar.
To close a table, query, form or report click Close button.

Changing between Objects & View Modes
Each database object has two different view modes:
Object

View Modes

Tables

Datasheet view and Design view

Queries

Datasheet view and Design view

Forms

Form view and Design view

Reports

Print Preview and Design view

To switch between view modes in a table or query:
1.
2.
3.

Click the Home tab.
Click View.
Click Datasheet View or Design View.

Note that:


The Design View shows the design of the table i.e. the
fields and field properties making up a table.



The Datasheet View displays data from a table in a rowand-column format. In Datasheet view, you can edit
fields, add and delete data, and search for data. In
Access 2010, you can also modify and add fields to a
table in Datasheet view.

To switch between view modes in a form or report:
1.
2.
3.

12

Click the Home tab.
Click View.
Click Form View / Report View or Design View.
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Deleting a Table, Query, Form & Report
To delete a table, query, form or report:
1.
2.

In the Navigation Pane, click the table, query, form or report to delete.
Press DELETE key. A warning message will be displayed prompting you to
confirm whether you want to proceed with deleting the object or not.

3.

Click Yes button to delete the object.

Navigating between Records in a Table, Query or Form
MS Access provides several methods to move between records in a table, query or
form.
Click the mouse directly in the cells of the table/query.
Use the navigation buttons in the lower left corner of the Datasheet view.




Moves to the
first record

Moves to the last
record
Moves to a blank
record

Moves to the
previous record

Moves to the next
record

Type a record
number to move to



Use the keyboard to move around the table/query.

Do this

Cursor moves

TAB, ENTER or RIGHT CURSOR key

To the next field in the table.

SHIFT+TAB or LEFT CURSOR key

To the previous field in the table.

UP CURSOR key

Up one record.

DOWN CURSOR key

Down one record.

HOME key

To the beginning of a record.

END key

To the end of a record.

CTRL+HOME key

To the beginning of the table.
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Do this

Cursor moves

CTRL+END key

To the end of the table.

Double click the Record Number box, type the
record number and press ENTER key.

To the specified record.

Note that:


If you are editing the contents of a field, the HOME, END, LEFT CURSOR
and RIGHT CURSOR keys will move the cursor within the characters typed in
the field. The entire field must be selected for these keys to move the cursor
between fields in the record.

You can navigate within the fields of a record in a form as indicated here:
Press

To move

TAB key

To next field in the record.

SHIFT+TAB keys

To previous field in the record.

HOME key

To move to the first field in the record.

END key

To move to the last field in the record.

Sorting Records
By default, the records are sorted by the primary key field. You can change the order
of records in tables, forms or query results through sorting. Records can be sorted in
ascending or descending order by any field.
To sort records in tables, forms or query results:
1.
2.
3.
4.

Click the Home tab.
Display the data in the Form View or table/query Datasheet view.
Click the field you want to use for sorting records.
In the Sort & Filter group,
Click Ascending
or Click Descending.

Note that:
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When you sort a field in ascending order, any records in which that field is
blank are listed first.
To sort dates and times from earlier to later, use ascending order. Use
descending order to sort from later to earlier.

ECDL Syllabus 5 Courseware



Module 5

TABLES

Adding & Deleting Table Records
To add records in a table:
1.
2.
3.
4.

Open the table in Datasheet view.
Click New (blank) record button. The cursor will move to the first
empty cell after the last record.
Type the data in the fields of the next row.
Repeat steps 2-3 to enter more records.

Note that:


As you work with records, the record selector button to the left of the record
will indicate the record’s status.
Record Selector

Description
A new record that you can enter information in.
The record that is being edited; changes are not yet saved.



A blank record will show at the end of the table with an asterisk (*),
indicating the location where any new record will be entered. As you add or
edit data in a record, a pencil will display, indicating you are entering or
editing data that has not been saved. When you move to another record or
close the datasheet, the pencil will disappear and the data will automatically
be saved. There is no need to save the table unless you have changed its
design or layout.



Pressing ESC key will undo the current field. If pressed twice, it will undo the
current record.

Occasionally, you may need to delete a record(s) from your database. When you
delete a record, or row, from the database, the records below the deleted row are
automatically moved up.

15

To delete a record(s):
1.
2.

Select the record(s) to be deleted by clicking the Record Selector buttons.
Press DELETE key. MS Access displays a warning dialog box prompting you
to confirm or cancel the deletion of the record(s).

3.

Click Yes button to confirm the deletion or No button to cancel the deletion
request.

Note that:


When you delete a record this will be permanently deleted i.e. you cannot
undo a deleted record.

Adding, Modifying & Deleting Record Data
To add data in a record:
1.
2.
3.
4.
5.

Open the table in Datasheet view.
Type the data in the first field.
Press TAB or ENTER key to move to the next field.
Repeat steps 2-3 to enter data in the other fields.
When you reach the end of the first record, press TAB or ENTER key to save
the data and automatically move to the next record.

Editing a record is similar to editing text in MS Word or MS Excel. You can insert,
delete and replace data in any field.
If you want to add text to a field, click where the new text will be inserted and begin
typing. Use the BACKSPACE and DELETE keys to delete characters to the left or right
of the cursor. To delete an entire field, select the field and press the DELETE key. To
replace text, select the text to be replaced and start typing.

16
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If you make a mistake as you are editing and the changes have not been saved yet
(i.e. the pencil icon shows in the Record Selector button), click the UNDO button or
ESC key to cancel your changes. Pressing ESC key once will cancel changes made to
the current field. Pressing ESC key twice will cancel all changes made in the record.

Creating a New Table
A database file stores data in tables. You always start your database through the table
object. Tables can be created in Design View.
The Design View is used to define the field names, the order the fields will appear in
the table, the type of data each field will contain, and the size and format of each
field. You can also add field descriptions to help you remember what information
should be entered into a field. These descriptions display in the lower left corner of
your screen as you enter records in Datasheet view.
To create a table in Design View:
1.
2.

Click the Create tab.
In the Table group, click Table Design. A new window appears for
inputting field names, their data types and descriptions.

3.

For each row in the table enter the field name, select a data type (read
further down to learn about data types) and type a description (optional). Use
the TAB key to move from column to column.
Once you enter all field names, data types and descriptions, select a field and
set this as the primary key. (Read further down to learn how to set the
primary key).
When you finish click Save button. The Save As dialog box is displayed.

4.
5.
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6.
7.

In the Table name: field type a name for your table.
Click OK button.

Note that:


In a table, a ‘row’ represents a record. In Design view a ‘row’ represents one
column in the table. For example, if in Design view you name a row ‘Index
No’, the table will have a column called ‘Index No’ and each record in the
database will need to have an ‘Index No’ field entry.



When you save your table, remember to start its name with ‘tbl’. This naming
convention will later help you to identify this database object as a table.

Field Names
Listed below are some general rules for naming your fields:




Use any combination of letters, numbers, and special characters, except a
period (.), exclamation mark (!), accent mark (`), or brackets ([]).
Use a maximum of 64 characters.
Choose a unique name for each field.

Data Types
For every field name entered in the first column of the Design view window you need
to specify its data type. The data type determines the kind of data that you can store
in a field. MS Access provides you with a list of data types to choose from. The default
data type is ‘text’. The following table summarises the field data types to be used
during this course.
Data Type

Description

Examples

Storage Size

Text

Allows you to enter alphabetic or numeric
data. Typically used where there is a limit on
the amount of data. No calculations can be
done on numeric data entered as text data
type.

Name,
postcode,
address &
telephone
number.

Up to 255
characters.

Number

Allows you to enter numeric data that may be
used for calculations.

Quantity in
stock,
amount sold
& marks.

1, 2, 4, 8 or
16 bytes.

Date/Time

Allows you to enter Date or time data.

Date of birth,
Production &
expiry date,
time lap.

8 bytes.

Yes/No

Allows you to enter yes/no, true/false or on/off
values to a field.

18

Promoted,
Married.

1 bit.
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To choose a data type for a field:
1.
2.
3.

In Design view, tab to the Data Type column for the desired field.
Click on the drop-down arrow to display a list of data types.
Press the first character of the data type to be used e.g. ‘T’ for a Text field.

Applying Field Property Settings
Apart from specifying different data types for each field in your table, you can also set
the field properties to customise the appearance or contents of a field.
An example of a field property is the size of the field. Suppose, for example, you are
entering local postcodes of the format ZBG2409 or VCT1030. Because you know that a
local postcode is not going to be over 7 characters, you set the field size property to 7.
As another example, suppose you are entering exam marks. Because you know that
an exam result will not exceed 100, you set the field size property to Byte. The Byte
property accepts numbers in the range 0 to 255.
The properties and options available for a field are dependent on the field data type.
For example, a Date/Time field does not have a Field Size property.

Field Properties for a
field with a text data
type.

The following table summarises the field properties that will be used during this
course:

19

Field Property

Use

Field Size

Limits a text field to a certain size, or limits a number field to values within
the data type’s range.

Format

Displays dates, text, and numbers in a specific display format.

Caption

A name to be used as a column heading in a datasheet or as a label on a
form or report. The field name is used as the default label for a field if no
caption is specified.

Default Value

Automatically inserts this value in all new records.

Validation
Rule

Limits data entered to a specific value that meets a certain criteria.
Displays a dialog box if an acceptable value is not used.

Validation Text

Used to display a customised error message when the validation rule is
violated.

Required

Can be Yes or No. If Yes, data is required in the field and cannot be left
blank.

Indexed

Simplifies sorting. Also can be used to prevent duplicate values from being
entered in a field.

Changing the Field Size
The Field Size property limits the size of a field. You establish a field size to ensure
that the data entered in a field does not exceed a specified size.
Field size options are different for text and number fields:


For a text field, you can type a number to indicate the maximum number of
characters that can be entered in the field. For example, using the field
properties, you can change the size of a phone number field to 8 characters.
The default size for a text field is ‘50’ characters with a maximum field size for
a text field of ‘255’ characters.



For a number field, the field size indicates the range of values and whether
the field can contain fractional values. The default field size for a number field
is ‘long integer’, which means that the field must contain a whole number.
The following field size options are available for number fields:

Field Size Label

Accepts…

Storage size

Byte

0 to 255

1 byte

Integer

–32,768 to 32,767

2 bytes

Long Integer

–2,147,483,648 to 2,147,483,647

4 bytes

Single

Any number with up to 7 decimal places

4 bytes

Double

Any number with up to 15 decimal places

8 bytes

Decimal

Any number with up to 28 decimal places

12 bytes

To change the field size in a table:

20

1.

In Design view, click the field to set its field size.

2.

In the Field Properties (lower pane), on the General tab card, click the Field
Size box.
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Change the field size:
a. For a text field, type the number of characters that will be allowed in the
field.
b. For a number field, click the drop-down arrow to the right of the field
size label. Select the appropriate field size property (refer to the table
above).

4.

Click Save button.

Note that:


It is advisable to consider the data to be entered in a field and set the field
size property accordingly. Using a field size larger than needed can greatly
increase the size of the database file.



If your table already contains data and you reduce the field size, the following
dialog box will be displayed. If you decrease the size of the field that contains
data, this will be truncated if it exceeds the new width of the field. Click Yes
or No button as appropriate.

Changing Number Field Format
For ‘number’ and ‘currency’ there are several formatting options. For the ‘number’
field, the General format is automatically selected. For the ‘currency’ field, the
Currency format is automatically selected. The following format options are available
for Number and Currency fields:
Format
Property

Displays

General

Displays numbers as they were entered e.g. 7000. This is the default for Number
fields.

Euro

Displays as currency and uses the Euro symbol €.

Fixed

Displays two decimal places e.g. 7000.00.

Standard

Displays comma and two decimal places e.g. 7,000.00.
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Format
Property

Displays

Percent

Multiplies the value by 100 and shows % e.g. 50%.

Scientific

Displays standard scientific notation.

To change the field format of ‘number’ or ‘currency’ fields:
1.
2.
3.

4.

In Design view, click the ‘number’ or ‘currency’ field to set its format.
In the Field Properties (lower pane), on the General tab card, click the
Format box.
Click the drop-down arrow to the right of the Format label. Select the
appropriate format property (refer to the table above).

Click Save button.

Note that:


The percent format multiplies the number entered by 100 and adds the %
symbol. If you type the number 7, this will be displayed as 700%. To enter
7% type 0.07% or 7%.

Changing Date/Time Field Formats
The format of a ‘date/time’ field can include only the date, both the date and time, or
only the time. MS Access provides several date/time options to choose from.
Format Property

Displays as

General

If no time is entered, only the date is displayed. If no date is entered,
only the time is displayed. This is the default and is a combination of the
Short Date and Long Time settings.

Long Date

Wednesday, December 17, 2003

Medium Date

17-Dec-03

Short Date

17/12/03

Long Time

09:43:30 PM

Medium Time

09:43 PM

Short Time

09:43

Mm/dd/yyyy

17/12/03 will display as 17/12/2003
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To change the field format of ‘date/time’ fields:
1.
2.
3.
4.

In Design view, click the ‘date/time’ field to set its format.
In the Field Properties (lower pane), on the General tab card, click the
Format box.
Click the drop-down arrow to the right of the Format label. Select the
appropriate format property (refer to the table above).
Click Save button.

Applying & Modifying Default Values
In addition to changing the field sizes and formats, you can also use the field
properties screen to set default field values.
Default field values are values that automatically fill in a field in new records. You can
either leave the default value, or change the data to a new value.
Defining a default value for a field simplifies data entry when a certain value is entered
frequently. For example, in a student table, you might have a field for Town. If most
of the students come from Zebbug, you could set the default value to Zebbug. Then
you will only enter data in this field if the town is other than Zebbug.
1.
2.
3.
4.

In Design view, click the field that will have a default value applied to it.
In the Field Properties (lower pane), on the General tab card, click the
Default Value field.
Type the value to be displayed automatically.
Click Save button. When you enter data in new records, the default value will
automatically appear in the field.
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Creating & Editing Validation Rules
You can limit the data that can be entered into a field by defining a validation rule for
that field. If the data that is entered into the field breaks the rule, MS Access will
display a message indicating what kind of data entry is allowed.
Let’s assume that you have a ‘title’ field. You can use a validation rule to only allow
‘Mr’, ‘Ms’, ‘Dr’ and ‘Prof’ to be entered in the ‘title’ field. If you type ‘Mrs’, MS Access
will reject the entry and display an error message.
To make the error message more user-friendly, you can customise it by typing a new
message in the Validation text property box. In this way, you can communicate to the
user specifically what data is allowed in the field.
Validation rules are entered as expressions. The following table lists some expressions
that you can use in your tables.
Expression

Description

>7000

The number must be greater than 7000.

<=7000

The number must be less than or equal to 7000.

>7000 and <10000

The number must be greater than 7000 and less than
10000.

>=7000 and <=10000

The number must be between 7000 and 10000 (both
numbers included).

Mr or Ms or Dr or Prof

The data must be Mr or Ms or Dr or Prof.

Between 1/1/03 and 1/1/04

The data must be in 2003.

<>0

The number cannot be zero.

0 or >100

The number must be either 0 or greater than 100.
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Expression

Description

Like “J????”

The data must contain 5 characters and starts with the
letter J.

>=Date()

The date must be today’s date or a later date.

To set a validation rule:
1.
2.
3.
4.
5.
6.

In Design view, click the field that will have a validation rule applied to it.
In the Field Properties (lower pane), on the General tab card, click the
Validation Rule field.
Type the appropriate validation rule expression (refer to the table above).
Click the Validation Text field.
Type the message that will be displayed when data entry violates the
validation rule.
Click Save button.

Setting the Primary Key
The primary key is the field that uniquely identifies each record in a database table. It
is a field containing data that is different for every record in a database. Primary keys
prevent duplicate records because the field must contain a unique data item.
To define a primary key field in a table:
1.
2.
3.

In Design view, click the field to define as a primary key.
In the Tools group, click Primary key button. A key symbol will be
displayed in the record selector for the field name.
Click Save button.

25

Note that:


By definition, the primary key field cannot contain any duplicate entries. For
example, a ‘surname’ field cannot be defined as a primary key because the
surname field may contain the same data values in different records. For many
of the tables you design, there will be a field that provides unique values (e.g.
‘identity card number’, ‘passport number’, ‘index number’, and ‘item code
number’) that can function as a primary key. If not you can create a field that
contains artificially unique values to be your primary key.



Once you define a field as a primary key, MS Access will test the contents of
the field each time you add or edit a record. An error message will be
displayed if there is a duplicate or a blank entry. The primary key cannot be
left blank for any records of the table.



The data present in a table is automatically sorted by the primary key field.



By default, the primary key field (if there is only one key field in a table) is
indexed. The index speeds up searches on the primary key fields as well as
sorting and grouping operations.

To delete the primary key setting from a field:
1.
2.
3.

In Design view, click the field to remove its primary key setting.
In the Tools group, click Primary key button. The record selector will no
longer display the key symbol.
Click Save button.

Indexing Fields
An index speeds up searches on the indexed fields as well as sorting and grouping
operations. For example, if you search for specific students using the ‘surname’ field,
you can create an index for this field to speed up the search. By default, the primary
key field in a table is automatically indexed. However, you can set indexing on other
fields in a table.
When deciding which fields to use as indexes, look at the fields you expect to search
frequently for particular values, or that you will want to sort by. To set an index to a
field:
1.
2.
3.

4.
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In Table Design View, select the field be indexed. You can select a field by
clicking on its name in the Field Name column.
In the Field Properties (lower pane), on the General tab card, click the
Indexed field.
Click the drop-down arrow and select the appropriate option (refer to the
following table).

Click Save button.
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Option

To Do This

No

Deletes the existing index or leaves the field unindexed.

Yes (Duplicates OK)

Indexes the field, allowing duplicate values among fields in the table.

Yes (No Duplicates)

Indexes the field prohibiting duplicate values among fields in the table.

Note that you cannot index an AutoNumber or Memo field.
You can view and modify existing indexes in the table design view as follows:
1.
2.

Display the table in Design View.
In the Show/Hide group, click Indexes button. The following dialog
box will be displayed:

The following table describes the possible changes you can make to properties of the
indexes:
Option

To Do This

Sort Order

Select either Ascending or Descending.

Primary

Indicates whether the selected index is the primary key field.

Unique

Indicates whether the selected index prohibits duplicate field contents.

Ignore
Nulls

Indicates whether Access searches through fields that do not contain any data.
If Access ignores null values in an indexed field, it makes searches and sorts
more efficient.

Indexes can be deleted by selecting the index and pressing the DELETE key.

Adding Fields to Tables
To insert a new field in Design view:
1.
2.
3.
4.
5.

Click the Record Selector button to select the field row where you want the
new field to be inserted.
In the Tools group, click Insert Rows.
Type the name of the field and press TAB key.
Set a data type for the field.
Click Save button.
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Note that:


If you add a field after data has been entered, the new field will be blank for
all existing records.



When you add a new field, you are changing the table’s design. You must
save the changes to the table before you can switch to Datasheet view or
close the table.

Changing the Column Width
You can change the column size to accommodate a field heading or field entry in the
Datasheet view:
1.
2.

Position the mouse pointer over the right edge of the column heading for the
column you want to resize. The pointer changes to a double-headed arrow.
Drag the pointer to the right to increase the column width or drag it to the
left to decrease the column width.

Note that:
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If you double-click over the right edge of the column heading, the width of
that column will change to fit the longest entry in the field.
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RETRIEVING INFORMATION

An important feature of any database program is the ease with which one can search
for particular data. MS Access provides quick and efficient access to data.

Finding a Record Based on Given Criteria
You can search for data in the Table Datasheet View or Form view:
1.
2.
3.

Click the Home tab.
In Datasheet View or Form View, click the appropriate field that
contains the data you are looking for.
Click the Find button. The Find dialog box is displayed.

4.
5.

In the Find What: field, type the data that you are looking for.
Click Find Next button.

The Find dialog box contains several options you can use to control the way MS Access
searches the table.
Option

To Do This

Match

Allows you to select from three options: Any Part of Field, which searches
the field for any portion of the string you enter in the Find What text box,
Match Whole Field, which searches the field for a complete match of the
string you entered in the Find What text box, and Start of Field, which
searches the beginning of the field for the string you entered in the Find
What text box.

Search

Allows you to specify whether you will search from the current record
upward or downward.

Match Case

Searches for the string exactly as you typed it in the Find What text box,
including the use of uppercase and lowercase letters.

Search Fields
as Formatted

Searches for contents of the field as it is displayed based on specific
formatting or the input mask rather than, as it is stored in the database.
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Applying & Removing Filters
You may wish to display only a specific set of data present in your database. For
example, in a students table, you can filter data so that only records of students
residing in ‘Zebbug’ will be displayed. Filtering enables you to display only those
records in the table or form that meet specified criteria.
MS Access has two filtering options:


Filter By Selection – allows you to select a field in a record that has the data
you want to filter. You will need to set up a filter criterion. For example, you
will set the criterion - ‘Zebbug’ - to display only records of students residing in
‘Zebbug’.



Filter By Form – can be used to search for records using multiple criteria. For
example, you will set two criteria: ‘Philip’ and ‘Zebbug’. These criteria will
display only the records of students with the name ‘Philip’ and living in
‘Zebbug’.

To filter records in a table/form using the Filter By Selection:
1.
2.
3.
4.

Click the Home tab.
In the table Datasheet View/Form View, highlight
the data in the field you want to use as the filter
criteria.
In the Sort & Filter group, click Selection.
Choose the appropriate option. The filtered
records appear.

Note that:


The table window indicates the number of filtered records.



If you save and close a table with a filter applied, the next time you open the
table in Datasheet View all of the records will display.

To filter records in a table/form using the Filter By Form:
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1.

Click the Home tab.

2.

In the table Datasheet View or Form View, in the
Sort & Filter group, click Advanced.

3.

Click the Filter By Form. A ‘blank’ table or form will
be displayed.

4.

Click in the field that you want to specify in your
filter. Type the value or expression that you want to
filter by, or choose a value from the drop-down list.
Repeat for all the fields you wish to use in the filter.
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In the Sort & Filter group, click Toggle Filter.

Note that:


To remove the filters, click Toggle Filter.

Creating & Running Queries
In the previous section you have seen how you can search for specific data. MS Access
provides a powerful tool – the query object - to extract particular information from
your database file. A query allows you to select and display records that meet a
specified set of criteria. For example, showing only those records of students born
during ‘1983’ and residing in ‘Qormi’.
A query cannot be created unless the database file has at least one table. You can
base a query on a single table, on multiple tables, or on other queries. Queries are
particularly effective when you want to use fields from multiple tables that have a
relationship. You cannot use filters when you want to extract data from multiple
tables.
In MS Access you can create different types of queries. For the purpose of this course,
you will learn how to create select queries. A select query displays a datasheet of all
the records and fields matching the criteria you entered without changing any of the
data. The results of a query are known as a recordset.
Queries can either be created in Design View or by using one of the query wizards. In
this course you will learn how to create a query in Design View:
1.

Click the Create tab.

2.

In the Other group, click Query Design. The Select Query window
and the Show Table dialog box will be displayed.

3.

In the Show Table dialog box, double-click the table/s on which the
query will be based. When you double-click on a table, a list of
available fields will be displayed at the top pane, known as the table pane, of
the query window.

4.

Click Close button in the Show Table window.
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The Select Query window is divided into two areas: the table pane (top pane)
and the QBE grid (bottom pane).
The QBE (query by example) grid is a collection of cells where you define the
query. Use the first row (Field) for the query’s field names. Use the third row
(Sort) for sorting options. Use the fourth row (Show) to determine which
fields appear in the query results. Use the rest of the rows (Criteria, and so
on) to set up your criteria.

Table Pane
Field List

QBE Grid

5.
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In the table pane, double-click the field name/s (in the field lists). The Field:
(first row), in the QBE grid, will display the field name selected. The Table:
(second row), in the QBE grid, will automatically display the name of the table
which has the selected field.
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6.

Repeat this step for the other fields that will be included in the query. The
order in which you select your fields is the order in which they will appear in
the recordset (the results of a query).

7.

Click the drop-down arrow in the Sort: box and select the sorting order
[ascending, descending or (not sorted)] for the data in that field. Use
ascending order to sort dates and times from earlier to later. Use descending
order to sort from later to earlier.

8.

In the Criteria: box type an expression (read further down) and press ENTER
key. Criteria are used to extract a specific set of data. The basic idea is that
you select a field and then enter an expression that defines your criteria. For
example, to extract details of students who got less than 55 in their English
exam type <55.

9.

Deactivate any check box/es in the Show: cells for the field/s that will not be
displayed in the recordset. In most cases such fields are added to the QBE
grid for criteria purposes only. You can unhide the field/s by unchecking the
Show: check box.

10. In the Results group, click Run to display the results of the query.

11. Click Save button to save your query. The Save As dialog box will be
displayed.
12. In the Save As dialog box, type a name for the query in the Query Name:
13. Click OK button.
Note that:


When you save a query, remember to start its name with ‘qry’. This naming
convention will later help you to identify this database object as a query.



You should save your query if you plan to re-use it. Saving your query will
save the query’s structure, not its results. If you add data to a table that
matches the criteria (read further down) in the query, and then you run the
query, a new up-to-date recordset is generated.
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Adding Criteria Using Comparison Operators
Criteria expressions are short statements that tell MS Access what subset of your data
you want to see. The following table displays the comparison operators that can be
used in criteria expressions:
Symbol

Description

Symbol

Description

>

Greater than

=

Equal to

<

Less than

>=

Greater than or equal to

Less than or equal to

<>

Not equal to

<=

Typically comparison operators are used on numeric or date fields. However you can
also use them on text fields. For example, the expression <’D’ will match field values
that begin with letters A, B or C.
Expression
=Borg

Field
Surname

<>John

Name

<=G

Surname

=78772M

ID

Description
Displays records where Surname is ‘Borg’.
Displays records where Name is not equal to ‘John’.
Displays records where the Surname begins with letters A
through G.
Displays the record where ID is 78772M.

<30

English

Displays records where English is less than 30.

>=45

Maltese

Displays records where Maltese is greater or equal to 45.

>1/1/95

Date of Birth

Displays records where Date of Birth is after 1/1/95.

Note that:


If you want your data to match an exact value, there is no need to use the
equal symbol (=) in your criteria expression.

Example: You add a single selection criterion to the Criteria: cell in the QBE grid:
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Running the above query displays all students whose surname is ‘Mifsud'. Note that
when you type Mifsud and click another cell, Mifsud will be displayed as “=Mifsud”.

Adding Criteria Using Logical Operators
In addition to specifying one criterion for one field, you can also specify criteria for
different fields. This is accomplished by setting up AND and OR logical operators.
AND Criteria
If you specify criteria for two or more fields on the same criteria row, you create an
AND condition. The AND condition means that all the specified criteria must be met for
a record to appear in the recordset.
Example 1 - If you want the records of those students whose surname is ‘Mifsud’ and
their mark in the English exam is ‘over 65’, you will type the following in the criteria
row:

Specifying multiple
criteria on the same
row, creates an AND
condition between
different fields.

Example 2 - If you want the records of those students whose mark in the English
exam was between 65 and 80 (65 and 80 are included), you will type the following in
the criteria row:

Specifying multiple
criteria on the same
field.

OR Criteria
If you specify criteria in different rows of the QBE grid, you create an OR condition.
The OR condition means that records meet criteria for any of the fields that will be
included in the recordset.
Example 1 - If you want the records of those students who failed in English or Maltese
(less than 45), you will type <45 in the Criteria row and <45 in the Or: row:
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Specifying multiple
criteria on different
rows, creates an OR
condition between
different fields.

Example 2 - If you want the records of those students whose surname is ‘Mifsud’ or
‘Muscat’, you can type any of the following:

NOT Criteria
The NOT operator looks for records that don’t match a particular logical expression.
Example 1 – If you want the records of all employees who do not live in Atalanta, you
type the following:

Combination of AND and OR Criteria
You can also combine the AND and OR logical operators. This can be useful when you
want to use a different AND condition with different criteria for the same field.
Example - If you want the records of those students whose surname is ‘Mifsud’ or
‘Muscat’, and who have failed in English, you can type any of the following:

36
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Adding Criteria Using Wildcards
If you type specific text, MS Access will match the text exactly. If you need to allow
for multiple spellings in a text field, or if you are not sure how to spell a word you
want to use, the wildcard characters can help. There are two wildcards: the asterisk
(*) and the question mark (?).
You can also use the asterisk (*) and question mark (?) characters as wildcards. The *
is used to take the place of multiple characters, and the ? is used to take the place of
a single character. The following table shows sample expressions and their results:
Expression

Description

Like “Re?d”

Matches records where the field value is Reid, Read, reed etc.

Like “M?”

Matches records where the field value is MA, MD, ME etc.

Like “R*”

Matches records where the value begins with R.

Like “*office*”

Matches records where the field value contains the word office.

Like “*/12/96”

Matches records where the field value is any date in December 1996.

Example: If you want the records of those employees whose name ends with the letter
‘y’ or the second letter of the surname is ‘o’, you can type any of the following:

Editing a Query
To add, modify or remove criteria:
1.
2.
3.
4.

Display the query in Design view.
In the QBE grid, click in the Criteria: / Or: row of the field.
Add, edit or delete the criteria as necessary.
Click Save button.

To insert additional fields to a query:
1.
2.

3.

Display the query in Design view.
In the table pane, double-click the field name/s (in the field lists). The Field:
(first row), in the QBE grid, will display the field name selected. The Table:
(second row), in the QBE grid, will automatically display the name of the table
which has the selected field.
Click Save button.
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To remove fields from a query:
1.
2.
3.

Display the query in Design view.
In the QBE grid, click the small grey cell above the name of the field to
remove. The entire column will be highlighted.
Press DELETE key.

Note that:


You cannot undo deletions in queries in Design view. If you accidentally delete
a field, you will have to add it again to the query.

To hide field/s from being displayed in the recordset:
1.
2.

Display the query in Design view.
In the QBE grid, deactivate the check box/es in the Show: cells for the field/s
that will not be displayed in the recordset. In most cases such fields are
added to the QBE grid for criteria purposes only.

To unhide field/s so that these will be displayed in the recordset:
1.
2.
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Display the query in Design view.
In the QBE grid, activate (click) the check box/es in the Show: cells for the
field/s that will be displayed in the recordset.
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OBJECTS

Creating Forms
A form is a type of a database object that is primarily used to enter or display data in
a database. Earlier in this course, the table object was used for data entry, editing and
viewing. The form object provides a more user-friendly interface for data entry,
editing and viewing.
A form is another way of looking at data in a table. If you add or edit records in a
form, you are actually changing the data in the underlying table. When you work with
data in a form, all the field properties in the table’s design will apply, including default
values and validation rules.
The form wizard helps you create a form quickly. The wizard asks you questions and
creates a form based on your answers. You can then customize the form the way you
want it in Design view.
To create a form using the form wizard:
1.

Click the Create tab.

2.

In the Forms group, click Form Wizard. This will start a
wizard that asks you questions and creates a form based on
your answers.

3.

Click the drop-down arrow below Tables/Queries: and select the table or
query (discussed in a later section) that contains the data to be used in the
form.

4.

The left part (under Available Fields:), displays a list of fields that make up
the table or query selected in the previous step.
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Double-click the field to include in your form. This field will move to the
Selected Fields: list. Repeat this for all fields that you wish to include in your
form.
You can remove fields from the Selected Fields: list by double-clicking the
fields to remove.
Click Next button. The next Form wizard dialog box is displayed.
5.

Select one of the four layout options Columnar, Tabular, Datasheet or
Justified. When you select a layout, a sample appears in the left pane.

Click Next button. The next Form wizard dialog box is displayed.
6.
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In the What title do you want for your form? type a name for your form.
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Select whether you want to start entering data in the form or you want to
modify the form’s design. If you select the option Open the form to view
and enter information the Form view window will be displayed.
Click Finish button.

Note that:


When you save a form, remember to start its name with ‘frm’. This naming
convention will later help you to identify this database object as a form.

Entering, Modifying & Deleting Records in Forms
To add a new record in Form view:
1.
2.

Click New Record button. A blank record will be displayed.
Type in the data.

Note that:


Data entry through a form is equivalent to data entry in a table. Therefore
data entered via the form object also goes in the table on which the form is
based on.

To modify/edit data within a field:
1.
2.

In the Form View, click in the field you want to edit.
Type in the data.

Note that:


When you move to another record, MS Access saves your changes.
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To delete a record:
1.
2.
3.
4.

Click the Home tab.
In the Form View, position the cursor in any field of the
record to be deleted.
In the Records group, click Delete.
Click the Delete Record.

5.

Click Yes button to proceed with deleting the selected record.

Adding & Modifying Text in Form Headers & Footers
The Form Wizard is an essential tool for creating a form. However, you may need to
modify the design of a form. For example, to add/edit a header or footer you will need
to use the Form Design View.

Labels
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Fields
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The Form Design View window displays:





Form Header – containing the text or graphic that is displayed at the top part
of every form.
Detail – containing the labels and fields. The labels hold the field names or
caption from the fields’ properties. The fields hold the table data. Each label
and its corresponding field are collectively known as bound controls.
Form Footer – containing the text or graphic that is displayed at the bottom of
every form.

To add a header and/or footer to the form:
1.

Switch to the form Design View. To view the footer increase the size of the
Form window through the bottom right corner border of the Form window.
By default the
frmBorrowers.

2.

Form

Header

displays

the

name

of

the

form

e.g.

Click in the header text. Do one of the following:
Edit or delete the header text.
If there is no header text:
a.

In the Controls group, click Label.

b.

Create a text box in the Form Header. The cursor will be displayed in
the text box.

c. Type the header text.
d. Click outside the text box.
3.

Click below the Form Footer.

4.

In the Controls group, click Label.

5.

Create a text box in the Form Footer. The cursor will be displayed in the text
box.

6.

Type the footer text.

7.

Click outside the text box.

8.

Click Save button.

To edit the form header or footer text:
1.
2.
3.
4.

Switch to the form Design View.
Click in the header or footer text box to edit.
Edit the text.
Click Save button.
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OUTPUTS

Creating Reports
The records in a table or query can be printed in a spreadsheet-like format. The
records in a table or query can be printed using the reports object. The reports object
enables you to select, organise and print records a customised format.
The report wizard helps you create a report quickly. The wizard asks you questions
and creates a report based on your answers. You can then customize the report the
way you want it in Design view.
To create a report using the report wizard:
1.

Click the Create tab.

2.

In the Reports group, click Report Wizard. This will start a
wizard that asks you questions and creates a report based on
your answers.

3.

Click the drop-down arrow below Tables/Queries and select the table or
query that contains the data to be used in the report.

4.

The left part (under Available Fields:), displays a list of fields that make up
the table or query selected in the previous step.
Double-click the field to include in your report. This field will move to the
Selected Fields: list. Repeat this for all fields that you wish to include in your
report.
You can remove fields from the Selected Fields: list by double-clicking the
fields to remove.

Click Next button to display the next Report wizard dialog box.
5.
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To add a grouping level, double-click the field you want to group with.
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Grouping fields allows you to organise the content of your report. For
example, if you wish to group the records by ‘surname’, double-click
surname.
When you group a field, MS Access separates all of the records that relate to
that particular field. By grouping fields, you can create reports that are easier
to read when you need specific information grouped together.

Click Next button to display the next Report wizard dialog box.
6.

Determine how the report will display the sorting of the records. You can sort
the records by up to 4 fields in either ascending/descending order. Select a
field from the drop-down list box.
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If you have number or currency fields in your report, you can include
summations, averages, minimum, and maximum in your report. Click
Summary Options… button.

The Summary Options dialog box will be displayed. Tick the appropriate
options and click OK button. You will be returned to the previous Report
Wizard dialog box.
Click Next button to display the next Report Wizard dialog box.
7.

Select one of the layout options. When you select a layout, a sample appears
in the left pane.
Select whether you want to print your report in Portrait or Landscape
format.
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Click Next button to display the next Report Wizard dialog box.
8.

In the What title do you want for your report? type a name for your
report.
Select whether you want to preview the report or you want to Modify the
report’s design. If you select the option Preview the report the Print
Preview window will be displayed.

Click Finish button.

Note that:


When you save a report, remember to start its name with ‘rpt’. This naming
convention will later help you to identify this database object as a report.
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Changing the Arrangement of Data Fields & Headings
The Report Wizard is an essential tool for creating a report. However, you may need to
modify the design of a report. For example, you can change the arrangement of data
fields and headings.
The Design View displays the different sections in a report: Report Header, Page
Header, Detail, Page Footer and Report Footer.
Considering the rptResults: the Report window (displayed above) shows the headings
(Surname, Name, StudentID, Promoted etc.) in the Page Header section and the
corresponding data fields in the Detail Section. The headings hold the field name or
caption from the field’s properties. The data fields hold the table data.

MS Access groups all the fields in a layout. The layout is a
specialised container that lets you easily work with groups of
fields. When you move a column header, the column data moves
with it. When you move a column to a new position, MS Access rearranges all the other columns accordingly.
To change the arrangement of headings and data fields:
1.
2.
3.
4.
5.
6.
7.
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Switch to Layout View.
Click the column header of the field to move.
Press and hold SHIFT key.
Click the corresponding data field. All the data will be
highlighted.
Position the pointer in one of the selected data fields. The
pointer changes to a 4 pointed arrow.
Drag the 4 pointed arrow to the new location.
Click Save button.
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Modifying Report Headers & Footers
You may also need to edit or format the text in headers and footer objects in the
report. For example you may wish to edit the header of a report which by default is
the title name entered in the final step of the last Report wizard dialog box. To format
or edit report headers and footers:
1.
2.
3.
4.

In the report Design View, click in the report header/footer text box. Sizing
handles will be displayed.
Apply formatting options (e.g. typestyle, font style, size and colour) in the
header/footer text box.
To edit the text, click again the header/footer text box. The cursor appears in
the text box. Edit the text as necessary.
Click Save button.

Exporting Data from Tables & Queries
There may be times when you need to export data out of your MS Access database
into another format. You can export to a variety of file formats, including MS Excel,
text file, or XML format.
To export data to MS Excel:
1.
2.
3.

Open the table or query to export.
Click External Data tab.
In the Export group, click Excel. The Export - Excel Spreadsheet
dialog box is displayed.
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4.
5.
6.

Click the Browse… button and determine the location (disk/folder) where the
file will be saved.
Type a name in the File name: field.
Tick the other appropriate options e.g.
Export data with formatting and layout.
Open the destination file after the export operation is complete.

7.
8.

Click OK button. MS Excel will open and display the data.
Return to MS Access and click Close button to close the Export - Excel
Spreadsheet dialog box.

To export data as a text file:
1.
2.
3.
4.
5.
6.
7.
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Open the table or query to export.
Click External Data tab.
In the Export group, click Text File. The Export – Text File dialog
box is displayed.
Click the Browse… button and determine the location (disk/folder)
where the file will be saved.
Type a name in the File name: field.
Click Save button. The Export – Text File dialog box is displayed.
Click OK button. The Export text Wizard dialog box is displayed.
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Click Next button.

9. Choose the appropriate options.
10. Click Next button.
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9. Click Finish button.
10. Click Close button to close the Export – Text File dialog.
To export data as XML file:
1.
2.
3.
4.
5.
6.
7.

Open the table or query to export.
Click External Data tab.
In the Export group, click XML File. The Export – XML File dialog box
is displayed.
Click the Browse… button and determine the location (disk/folder)
where the file will be saved.
Type a name in the File name: field.
Click Save button. The Export – XML File dialog box is displayed.
Click OK button. The Export XML dialog box is displayed.

8. Choose the appropriate options.
9. Click OK button.
10. Click Close button to close the Export – XML File dialog.
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Change the Paper Orientation & Size
To change the paper orientation (portrait, landscape) of a table, form, query output or
report:
1.
2.
3.

Click the File tab.
Click Print.
Click Print Preview button. The Print Preview tab is displayed.

4.

In the Page Layout group, choose Portrait or Landscape.

To change the paper size of a table, form, query output or report:
1.
2.

Repeat steps 1-3 as above.
In the Page Layout group, choose Page Setup. The Page Setup
dialog box is displayed.

3.
4.

In the Paper Size: choose the appropriate option e.g. A4.
Click OK button.
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Printing
To print a page or selected record/s or a complete table, query or form:
1.
2.
3.

Click the File tab.
Click Print.
Click Print button. The Print dialog box is displayed.

4.

Tick the appropriate option:
All to print the complete table, query or form.
Pages to print page/s in a table, query or form.
Selected record/s to print the highlighted records.

5.

Click OK button.

To print specific page(s) in a report or the complete report:
1.
2.

Repeat steps 1-3 as above.
Tick the appropriate option:
All to print the complete report.
Pages to print specific page/s in a report.
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